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Introduction

The shipboard ion chromatograph (IC) is used to determine concentrations of major cations (Na*, K, Mgz+, and Ca2+) and anions (CI', Br’, 5042') in

pore water. Each ion set is separated and detected in its own flow path. Sample is directed from the anions and cations sample loops into their
respective chromatographic columns in which dissolved ions absorb to a stationary phase resin. A unique eluent flows through each column and
competes with sample ions for adsorption sites. This causes a gradual separation of sample ions into discrete bands within the column—ordered by
each ion’s strength of adsorption (influenced by ionic radius and ionic charge). The separated analyte bands are carried off by the eluent from the
column into a conductivity detector, which integrates each analyte’s signal over a short time interval. Analyte concentrations in the samples are
calculated based on calibration curves created prior to each sample sequence by analyzing a set of known standards and blanks.

In order to maintain a consistent retention time for each ion, the columns are housed in a temperature-controlled chamber and the eluent flowrate is
kept constant. For reduced background conductivity and better detection of the analytes, the anions flowpath employs a chemical suppressor and a
CO, exchange membrane between the column and the detector. These suppressors remove sodium and bicarbonate (as CO,) from the eluent

solution and convert anions to their more conductive acid counterparts.

Safety Considerations

The ion chromatograph is a fairly safe and straightforward instrument to use. The following are a succinct overview of several important safety
precautions that are described in more detail within this user guide.

® Concentrated nitric acid and sulfuric acid are necessary for the preparation of the cations eluent and suppressor regenerant solution,
respectively. Use proper PPE (nitrile/isoprene gloves and eye protection) when handling acids. Always add acid to water. Be aware of acid

spill control and neutralization kits.
® Be aware of the autosampler position and movements to avoid pinching a finger.

Instrument Diagram and Operation
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Figure 1: Metrohm 850 Professional lon Chromatograph ‘ \ ? \

Figure 2: Metrohm 850 Professional IC Autosampler

The Instrument Flow Path

The following is an overview of the sequence of events which occur when a sample is analyzed. Consult IC Flow Path and Function.pptx for greater
detail about the instrument flowpath.

1. The MSM (Metrohm Suppressor Module) switches to a new clean channel. The peristaltic pumps on the IC and AS initiate. Suppressor
regenerant and rinse flow through and clean the two alternative channels of the MSM. The eluent pumps continuously uptake eluent via the
bottles and degassers, and then flushes the path which connects the pump purge valves, pulsation dampeners, columns and detectors (the
anions eluent also flows through the MSM and MCS before reaching the detector).

2. Meanwhile, the autosampler moves the rack, injects the probe into a sample vial and begins uptake of the sample.

3. Sample flows in through the bottom of the ultrafiltration membrane housing, is filtered, exits the top, and is sent directly to the cations sample
loop, the anions sample loop and then to the waste container on the back of the instrument. The waste line from the ultrafiltration membrane
empties into a drain on the countertop.

4. After the sample has been drawn for a predetermined time necessary to purge the sample loops, the sample loop valves switch and sample
is forced into both columns. Eluent trails the sample pulse and maintains the flow. MagIC NET begins data acquisition.

5. The IC system maintains this configuration for the 28 minutes necessary for all the analytes to elute and the acquisition to finish. During this
time, the AS directs the probe to a waste vessel. The Dosino sends DI water to the vessel to clean the outside of the probe, then switches
ports and backflushes DI through the probe. The Dosino switches ports once more and flushes DI water through the sample lines which go
from the AS to the IC sample loop valves and exit to the waste container on the back of the instrument.

6. Once the acquisition is finished the system returns to its regular state in which only eluent, MSM regenerant and MSM rinse are pumped
through the IC. The MSM switches channels automatically every 10 minutes.

Suppressor

The IC employs the MSM to lower the background conductivity of the anions eluent in order to gain detector sensitivity while measuring anions. The
MSM is composed of an acidic cation exchange resin which exchanges hydronium ions for the sodium ions originating from the sodium bicarbonate of
the anion eluent. The bicarbonate is converted to carbonic acid which has a much lower specific conductivity (and is mostly removed in the MCS). In
addition, the anion salts are converted into their mineral acid counterparts, eg NaCl becomes HCI, NaBr becomes HBr, etc, which have much higher
specific conductivities.

The anions baseline is typically at 1.4 pS/cm. It is normal for the baseline to jump up to between 5-7 uS/cm when the MSM switches cartridges. The
baseline eventually stabilizes.

The Method

A Metrohm representative created the default method for data acquisition during the initial instrument installation. The Method consists of a time
program, device setup and type of chromatogram evaluation. The time program is a series of instrument events that control sample and eluent uptake
and flow through the system, it should never need to be adjusted by technicians or scientists. The Devices menu enables the user to assign hardware
and hardware parameters. The menu is particularly useful to assign variable names and locations to the hardware (pumps, columns, detectors, etc)
that the method uses for control and data calculations. Finally, the Evaluation menu contains the parameters necessary for analyzing
chromatograms, constructing a calibration curve and compiling results. Use this menu to add additional calibration standards, check standards, or to
specify additional analytes and their retention times.
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Reagents

Make sure all reservoirs are filled with the following reagents:

Dosino | 18 mega-ohm DI water
Reservoir

Suppressor | 0.1% methanol in DI water (1 mL methanol to 1 L DI water)
Rinse Solution

Suppressor | 0.05 M sulfuric acid solution (2.7 mL sulfuric acid to 1 L DI water)
Regenerant
Solution

Anions Eluent | 3.2 mM sodium carbonate/1.0 mM sodium bicarbonate solution (purchase concentrated packs from Metrohm, called “A Supp 5
Eluent Snips”)

® snip off tube with scissors and pour contents into a 1 L volumetric flask
® rinse the tube with DI water, adding to the flask
® bring flask to volume

Cations Eluent = 1.7 mM nitric acid/1.7 mM PDCA (pyridine-2,6-dicarboxylic acid)

dissolve 0.248 g PDCA in DI water in a 1 L flask

add 106 pL concentrated trace metals grade nitric acid

bring flask to volume with DI water.

To make a carboy’s worth, in a 2 L volumetric flask, mix 872 pL nitric acid, 2.272 g PDCA with DI water and bring to volume.
Pour into the carboy and add three more 2 L flasks filled with DI water. Place on stir plate and stir with a magnetic stir bar for
at least 24 hrs.

Preparing the Calibration Standards and Samples

Standards

The dilution scheme for the standards from IAPSO standard seawater is displayed in the following table. Use a fresh bottle of IAPSO every expedition.
To reduce contamination of the IAPSO bottle, decant a few mLs of IAPSO into a secondary container and use this volume to prepare standards.
Parafilm the IAPSO lid after use to reduce evaporation. Additional calibration standards may need to be prepared to constrain the instrument response
for low analyte levels.

Prepare a standard curve, 10 mL per level, in IC vials:

Standard 1 | Standard 2 ' Standard 3 Standard 4  Standard 5 Standard 6 Standard 7 DF1000 Standard 8 Standard 9
DF67 DF80 DF100 DF133 DF200 DF400 DF2000 DF10000
(From DF100)
(From DF100) (From DF100)
IAPSO (uL) 150 125 100 75 50 25 1000 500 100
DI water (L) 9850 9875 9900 9925 9950 9975 9000 9500 9900

To prepare "pourable” 100 ml standards, use the following recipe: (pipette IAPSO in a 100 ml volumetric flask and bring to volume with DI water)

Standard 1  Standard 2 | Standard 3 Standard 4 Standard 5 Standard 6 Standard 7 DF1000 Standard 8 Standard 9
DF67 DF80 DF100 DF133 DF200 DF400 DF2000 DF10000
(From DF100)
(From DF100) (From DF100)
IAPSO (mL) 15 1.25 1 0.75 0.5 0.25 10 5 1
DI water (mL) 98.5 98.75 99 99.25 99.50 99.75 90 95 99

To add/edit standards, select METHOD panel and Standards in the Evaluation window. Here you can also add/edit check standards information.
Standard concentrations of 0 for particular analytes are not considered by the software when calculating the analyte calibration curve.

IAPSO Concentrations

Constituent Standard 1 Standard 2 | Standard 3 Standard 4 Standard 5 Standard 6 Standard 7 | Standard 8 = Standard 9

150% 125% 100% 75% 50% 25% 10% 5% 1%
Sodium (mM) 721.0 600.9 480.7 360.5 240.3 120.2 48.07 24.03 4.807
Potassium (mM) 15.69 13.08 10.46 7.847 5.231 2.616 1.046 0.5231 0.1046
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Calcium (mM) 15.81 13.18 10.54 7.906 5.271 2.635 1.054 0.5271 0.1054

Magnesium (mM) 81.21 67.67 54.14 40.60 27.07 13.53 5.414 2.707 0.5414
Chloride (mM) 839.3 699.4 559.5 419.6 279.8 139.9 55.95 27.98 5.595
Bromide (mM) 1.295 1.079 0.8632 0.6474 0.4316 0.2158 0.08632 0.04316 0.008632
Sulfate (mM) 43.41 36.18 28.94 21.71 14.47 7.235 2.894 1.447 0.2894

A note on calibrations:

MagIC Net deals with calibration curves slightly different from other types of laboratory instrumentation. When a new batch of vials are run, the
calibration from the previous run (which is the active calibration) is gradually overwritten by the individual calibration points of standards in the new
batch. For example, after STD 1 is analyzed the calibration curve will consist of STD 1 and standards from the previous run (less the previous STD 1).
After STD 2 is analyzed, the calibration curve consists of STD1, STD2 and the other levels of standards from the previous analysis. Eventually, all
standards are analyzed and the active calibration consists only of calibration points from the current analysis. It is then samples may be analyzed. It is
important to recognize that classifying an aliquot in the sample sequence as a “Standard” will cause the software to incorporate it into an updated
calibration curve. This is desirable at times, but if the user analyzes a standard simply to check analytical accuracy or monitor instrument drift, then
they should classify the aliquot as a “Check Standard” or a “Sample”. MagIC Net has the functionality to edit and apply calibration curves post run.
Consult the section about reprocessing samples for instructions.

Samples
All samples are diluted 1:100 (100 pL sample made up to 10 mL with DI water).

However, this dilution scheme may need to be adjusted for pore waters with high salinity relative to IAPSO. The Hamilton dilutor is quicker and more
precise than using the Eppendorf pipettors for adding the DI water. Use the Eppendorf pipettors for adding sample to each vial. Make sure to switch
the pipette tips between each sample. Vortex mix the samples and standards before analysis.

Instrument Operation

Method Setup

Load a method to configure the IC’s operational parameters. The method loaded will be the method used by MagIC Net for the instrument
equilibration. Other saved methods may be specified individually for each sample in the sample sequence.

1. Opening and saving a method
a. Open MagIC Net 3.2, select METHOD icon in left panel.
b. Select File -> Open -> select the method.
c. You can then save the method with a new name for the current Expedition (File -> Save As).
2. Make a new database for the Expedition (saves results in a central Expedition database)
. Select DATABASE icon in the left panel.
. Select File -> Database Manager.
. Select Edit pulldown then New.
. Type in a new name (e.g. x376).
Here you can also make a database backup. Select Database Manager again and Backup, giving a unique Expedition name.
Go back to the METHOD panel. In the Evaluation window, click on Results icon.
. Select the Database tab.
. Double-click on the Name Database field and select your database name for the Expedition.
i. Save the method
3. Go back to the WORKPLACE icon in the left panel. Select the method that you want the instrument parameters to be set at (Equilibrium
tab).

SQ D Q0T

Setting up the instrument

1. Prepare the reagents specified above.

2. Ensure all instrument consumables are functioning properly; see the Maintenance schedule for when to replace a part.

3. Engage the pump tubing on the autosampler and MSM peristaltic pumps. Align the marks on the latches with those on the plastic frames
then tighten by one additional click.

4. Ensure the door to the column housing is closed and screwed shut. Verify that the Teflon tubing coming from the columns is passing through
notches on the side or on the top of the door. The door must not pinch the tubing.

5. Open MagIC Net 3.2, click on the Workplace button on the left-hand side of the application window. Within the Equilibration tab, click Start
HW.

a. To shut down the instrument, click Stop HW.

6. The instrument will begin the uptake of eluent through both flow paths. Allow the system to equilibrate for an hour. Every ten minutes the

MSM will switch channels and small pulse in conductivity (~6 uS/cm) will appear in the anions signal.
a. The anions baseline should stabilize around ~1 uS/cm. The cations baseline should stabilize to ~900 uS/cm.
b. The anions pump pressure should stabilize between 6.5-8 MPa, the cations pump pressure should stabilize between 4-4.5 MPa.
c. The column temperature thermostat should stabilize at 45°C.

7. While the instrument is equilibrating check to ensure there are no leaks in the eluent flowpaths. Typically, leaks form around the pump
fittings, the inline filters and the guard columns. If a leak is present, untighten the connection, resituate it with the fluids still flowing, and then
wipe off any mess. This ensures that a minimal amount of air enters the flow path.

8. The first vial analyzed usually yields spurious concentrations due to air being in the sample path. If the autosampler probe, any tubing, filters
or fittings along the sample flowpath or the ultrafiltration membrane have been changed, the flowpath will need to be rinsed. To prime or rinse
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the flowpath, navigate to MANUAL, select the Dilution Dosino, change the port to “2” and the input volume to 10 mL, ensure the Dosing radio
button is selected, then press Start. Verify the Dosino is priming the flowpath by watching fluid elute from the sample line into the waste
container on the back of the instrument.

Setting up a Sequence

The sample sequence consists of a Sample Table created in MaglC Net workplace. The Sample Table contains information on how a sample will be
analyzed (Method), how the sample is identified (Ident and Info 1), its position in the AS (Position), how the sample is classified by MagicNet for
calibrations (Sample Type), and dilution factors (Dilution) to be incorporated into the final calculation of concentrations.

® To set up a sequence, select the WORKPLACE panel and Determination Series tab.
® To create a new sample table, use the dropdown menu Sample Table -> New.
® Go to Sample Table drop-down and select Properties. In the Display tab, make sure that the Value 1 radio button is checked. Now go to
the Edit tab and make sure that the Value 1 radio button is checked.
® Double click the first row to start populating the sample/sequence table. The table should follow a basic guideline as follows (see Figure 1).
© The calibration standards will come first, followed by the blank (DI used as a sample)
© acheck standard
© then the samples
o checks every ten samples or so
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Figure 1 : Sample/sequence table example

Me | 369 (expedition number)
th
od

Ide = Text_ID of the sample. Standards are not yet entered into the LIMS so use something like DF100 or DF100 CHECK (for a check standard).
nt = The TextID must be entered here for MUT to upload the data to LIMS properly.

Sa Sample, Standard 1-9, Blank or Check Standard (check standard number refers to standard number)
mp
le
Ty
pe
Po | Autosampler vial position
siti
on
Inj 1
ect
ions

Vo 10puL
lu
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Dil | Select “1.” Dilution is supposed to be the dilution factor for manual or hand dilutions performed by the analyst prior to the sample being placed

uti | in the system; however, the standards are built around 1:100 being baseline, so we don’t want the software to calculate dilutions. Note:

on MagIC does not seem to identify updated dilution factors where it reports “Final Concentrations” when “reprocessing” samples after a run. In
these cases, use the values reported as “Concentrations”

Sa 1
mp
le

mo
unt

Inf | Here you can enter a comment or Label ID for example. Use this field to enter a name that the user may interpret (in contrast to the TextID
o0 1 | used in the Ident field).

Val = Dosino Dilution Factor, the dilution factor performed by the automated dilution system. For hand dilution, set this to “1.”
ue

® After the sample/sequence table is complete, go to the Sample Table pull-down, select Save As, and give a name.
® Place the vials in the appropriate position of the autosampler rack according to the sequence table.
® Click on the Start button to start the run. A display of the current aspiration will be shown on the Live Display Window.

The IC will analyze samples according to the order in the sample sequence, not necessarily the position in the autosampler rack. You can insert
samples into the sequence on fly by right clicking on the sequence table and selecting “Insert New Line”. Enter the sample info and double-check that
the Position corresponds to where to put the vial in the autosampler rack (at the end, for instance.)

Shutting Down the IC

To shut down the IC, navigate to the Equilibration tab and select the red Stop HW button. Eluent uptake will terminate. Disengage the tubing from the
peristaltic pumps on the IC and on the autosampler. Leave the instrument on.

Evaluating the Calibration/Results

An overview of IC calibration techniques may be reviewed here: IC Calibration Principles.pptx. The calibration curve and sample chromatograms may
be viewed by navigating to the Database panel and selecting a result of interest in the Determination Overview window. In the Curves 1 window are
tabs for Anions and Cations. Select either, the window will populate with the sample Chromatogram. Click on the Calibration curve radio button.
Select the element to evaluate from the pull-down menu to view its calibration curve and the calibration table (Figure 3). Several statistics and the
curve equation are also displayed in this window.

annnnal

Figure 3: Calibration curve display of a sample within the database tab.

The analysis results are also displayed under the Database tab within the windowpane entitled Results. Results are only shown if the software has
identified a peak within the retention time window specified for the analyte. The analytes are distinguished by the type of ion (cation or anion) and then
ordered by retention time. The result fields include the retention time, peak height, peak area, concentration (without accounting for dilution), and final
concentrations (with accounting for dilution). Beneath the results table is a list of all the parameters and equations defined in software to reach the
results displayed for the particular sample.

Information about the instrument configuration during the select sample acquisition may be found in the Information windowpane of the Database tab.

Reprocessing Data
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Occasionally sample chromatograms may need to be ‘reprocessed' if the software's autointegration feature has misidentified an analyte peak or if a
calibration curve needs to be adjusted and reapplied. Samples with low sulfate concentrations (below 1 mM) should be reprocessed using only the
lowest standards (1 mM and lower) as the y-intercept of the normal calibration underestimates the y-intercept for the low standards. The instructions
below are an overview of the reprocessing procedure. Consult the Metrohm documentation provided on this page for more detail about reprocessing
samples.

* Navigate to the Database

® Select the sample(s) that must be reprocessed. Right-click on the samples and select "Reprocess".

* A new dialog will appear displaying four window panes. The top left is a Reprocessing Table containing a list of the selected samples, the
top right consists of the currently selected sample Results, the bottom left consists of Evaluation Parameters (measurement acquisition and
calibration properties), the bottom right consists of sample Chromatograms and calibration curves.

® To reintegrate a peak, select the Integration button in the Evaluation Parameters window, then select the sample of interest in the
Reprocessing Table.

© Place the cursor over the peak displayed in the Chromatogram.
© To add a peak, right-click and select Add peak.
® The software autointegration will determine the integration area. If the retention time of the newly integrated peak coincides
with an analyte retention time listed in the Evaluation Parameters Components Table, then the software will automatically
assign and display the analyte name to the peak on the Chromatogram.
© To delete a peak, the cursor icon will change from a cross-hairs shape into a green peak icon.
= | eft-click to select the peak, then right-click and select Delete Peak.
® To Change the calibration
O Select either anions or cations in the Chromatogram windowpane and click on the Calibration button
O Select the analyte to be recalibrated
O Select a standard from the table, right click, and select off to remove a calibration point, or on add a removed calibration point
= Aremoved calibration point will be displayed as a red x in the calibration curve
© The type of calibration regression may be altered by clicking on the Calibration button on the right-hand side of the Evaluation
Parameters window and adjusting the "Curve Type" specified for the analyte of interest

® To save these changes, select the Reprocessing button on the bottom of the screen. In the Reprocess menu, select the From selected
determination radio button, and ensure the Keep manual integration checkbox is selected if you wish to keep any manual integrations.
Press OK.

© If the calibration was adjusted, ensure that the determination that was used for adjusting the calibration is selected.
© When the reprocessing occurs, the updates to the single sample will be applied to the rest of the samples in the Reprocessing Table.

* After a few moments the software will finish the calculations and the OK button on the bottom right of the processing window will illuminate.

Press this OK button to save the changes and return to the Database window.

Each change to reprocessed samples is saved into the Database archive. To undo a reprocess and restore a previous sample state, right click on the
sample and select "Show History." A new menu will appear showing a list of each time the sample has been reprocessed. Select a previous sample
state, right-click and select "Make Current." A duplicate of the previous sample will be generated into a new line and will become the current sample
displayed in the Database. To return to the Database, right-click the the new sample and uncheck the "Show History" box.

Uploading Data to LIMS

Use MUT uploader to upload results to the LIMS.

In the Database panel, select the result(s) to upload. Either click on a row or hold down the <Ctrl>-key and select multiple results.
In the top menu, select Determinations -> Export
Select All Selected Data Records and export template Exp368P. Click OK. The Excel csv files will be created in C:\Metrohm Export
Copy these csv files to the MUT uploader directory (C:\DATAI\in). Open MUT and upload.
Move the csv files in C:\Metrohm Export to an Expedition folder
o At the end of the Expedition copy over this folder to the DATA1 volume for backup for the shore db.

Helpful Hints and Tricks

The following hints will aid in monitoring and troubleshooting instrument performance while analyzing a sample sequence.

® At the beginning of the run note how much sample is being drawn from the vial. Compare the levels of the vials as the sequence proceeds to
ensure that sample is consistently extracted. If it is not, the peristaltic pump tubing may be wearing or an inline filter is clogged.

* Similarly, note the flowrates of the lines draining into the waste container on the rear of the instrument. Count the number of drops per 5 secs
as a rough estimate of flow. Monitor the rate during a sample sequence.

® Monitor the cations and anions baselines and pump pressures.

® Every time new eluent is added to the carboys the baselines and response for check standards changes slightly. This can be mitigated by
creating a large volume of a single cations solution. Do the same for the anions solution only at the beginning of an analysis. During a run, fill
up the eluent bottles fully at the beginning, and then refill once the level has gotten to the Teflon tip (don't let the tip contact air). This ensures
a maximum # of samples are analyzed under consistent conditions.

® Adding eluent to the reservoirs slightly alters the signal baseline, even if the eluent to be added is of the same batch as the eluent in the
reservoirs. It is best to “Pause” the run, let the current sample finish, add the necessary eluents, wait for ~30 minutes, and then “Cont”
(continue) the run. This is ample time for the new eluent mixture to saturate the flow path.

® |nsert check standards into the sample table on the fly if necessary, or if something major changed mid-run (changed inline filter, pump,
tubing, etc.)

® Sometimes the autosampler ends at a position where some vials cannot be accessed. To get the autosampler to move, select the Manual tab
on the main panel, then select 858 Professional Sample Processor. Select the Tower tab, change the rack position input, then click Start.

® The business card for the Service rep is taped to the side of the instrument.

® The help function in the software is good. Accessed from the top menu.
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Interpreting the lon Chromatograms
(Needs to be edited)
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Figures (x-x) are typical chromatograms collected when measuring an
aliquot of IAPSO diluted 1:100 (DF100). The order cations elute the ion
exchange column is governed by first by the strength of the ionic charge
and second, by cation size, where smaller, highly charged analytes are
the last to elute.

Maintenance Schedule

Changing Inline Filters

A general rule for changing an instrument component in the flowpath: Do
n't allow air to enter the flowpath! Bubbles in the lines ultimately end
in pump, analytical column or detector and can lead to problems with
each. When exchanging a component ensure the peristaltic pumps are
pumping fluid. Remove the component, insert the new component, and
allow the eluent to pump until the component fully fills and begins to spill
from the component's OUT side. Then, with the eluent still flowing,
connect the component OUT side to complete the flowpath. Doing so
will lessen the chance of air accumulating in the tubing and instrument
components. Wipe up any residual liquid mess.

In the case of changing the ultrafiltration membrane or autosampler
peristaltic pump tubing, disconnect the sample line at the in-line filter
located in between the autosampler and the IC. Run 1 sample of DI
water. The AS probe will draw in the water and flush the air from the
ultrafiltration membrane, new tubing and the in-line filter. After the last
bubbles have exited the in-line filter, reconnect the in-line filter to
complete the flowpath. Wipe up any residual liquid mess.

Figure 4: Frits within the guard columns. The left hand frit has a
buildup of iron oxides filtered from the sample to protect the
For maintenance, there are a couple of great guides, located in the anions column.
Metrohm_backup\METROHM MANUALS folder on the desktop

Main Instrument Guide: IC Essentials Manual.pdf

IC Maintenance Guide: IC Maintenance and Troubleshooting Guide.pdf
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Outlines maintenance schedules to follow

¢ changing autosampler ultra-filtration membrane
¢ changing H,0 and CO, scrubbers

® replacing peristaltic pump tubing

® changing the guard/inline filters

® pump maintenance
Autosampler Guide: Autosampler.pdf
Dosino guide: Dosino.pdf

Anion/cation pump maintenance: 850_pump_maintenance.pdf

Parts information to send in requisitions: Metrohm_parts_guide.
pdf

More on the autosampler’s ultra-filtration: Metrohm_ultra_filtration.
pdf

Software guide: Metrohm USA_MagIC Net User Guide.pdf

Calibration Techniques: IC Calibration Principles.pptx

Maintenance Schedule
Pumps: Once an expedition

Column: If the retention times are changing. The column should be one
of the last things to change when troubleshooting. They are expensive!

Anions, Cations inline-filters: Every several runs
Guard Columns: Every several runs

H20 Scrubber: Check every run, replace if the beads start to fade from
orange to transparent

CO2 Air Scrubber: Check every run, replace if the material within
begins to clump.

MSM Peristaltic Pump tubing: Every Several Runs

Any tubing: On an as needed basis, if there is a lot of sample carryover.

Autosampler Probe: Check every run, replace as needed
Peristaltic Pump Tubing: Every several runs, or monthly

Ultrafiltration membrane: Inspect every run, replace if discolored.

Solutions

Cations Solution: Replace if the bottle has been sitting around for a
week or so

Anions Solution: Make fresh every analysis.

Water: As needed

Methanol: As needed

Sulfuric: As needed

Bottle Air scrubbers: Soda lime turns from white to pink when then

absorbent is near the point of exhaustion. The absorbent should be
changed out when 2/3 of it has changed color.

Data Available in LORE

Figure 5: Example of a clean inline filter membrane (left) and dirty
membrane (right).

Figure X: Example of H20 scrubbers used in-line with the MSM air
inlet. From left to right: a regenerated scrubber ready to use, a
scrubber removed from the instrument which must be regenerated,
a new scrubber which must be regenerated before use.
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Interstitial Waters Standard Report

Exp: expedition number

Site: site number

Hole: hole number

Core: core number

Type: type indicates the coring tool used to recover the core
(typical types are F, H, R, X).

Sect: section number

® A/W: archive (A) or working (W) section half.

Top offset on section (cm): position of the upper edge of the
sample, measured relative to the top of the section.

Bottom offset on section (cm): position of the lower edge of
the sample, measured relative to the top of the section.

Top depth CSF-A (m): position of observation expressed
relative to the top of the hole.

Top depth [other] (m): position of observation expressed
relative to the top of the hole. The location is presented in a
scale selected by the science party or the report user.
Sampling tool: tool used to collect sample

Data columns: header lists parameter measured and
concentration units, followed by wavelength (for ICP-AES) and
then analysis method.

Expanded IC Report

Exp: expedition number

Site: site number

Hole: hole number

Core: core number

Type: type indicates the coring tool used to recover the core
(typical types are F, H, R, X).

Sect: section number

A/W: archive (A) or working (W) section half.

text_id: automatically generated unique database identifier for
a sample, visible on printed labels

sample_number: sample number of sample. text ID with
sample type prefix removed.

label_id: id combining exp, site, hole, core, type, sect, A/W,
parent sample name (if any), sample name

sample_name: name of sample

X_sample_state:

X_project: expedition project the sample is uploaded under.
typically the same as Exp.

x_capt_loc:

location: location sample was taken

x_sampling_tool: tool used to collect sample

changed_by: name of person who uploaded sample
changed_on: date and time sample was uploaded
sample_type: type of sample. typically LIQ, for liquid.
x_offset: top offset of parent sample where sample was taken
inm

x_offset_cm: top offset of parent sample where sample was
taken in cm

x_bottom_offset_cm: bottom offset of parent sample where
sample was taken in cm

x_diameter:

Xx_idmp:

x_orig_len:

x_length: length of sample in m

x_lengeth_cm: length of sample in cm

status:

old_status:

original_sample:

parent_sample:

standard:

login_by: name of person logged into LIMS application used
for this test

sampled_date:

legacy:

test changed_on: date of last edit of analysis

test date_started: date analysis was started

test group_name:

test status:

test old_status:

test test_number: unique number associated with the
instrument measurement steps that produced these data
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test date_received: date analysis was uploaded to LIMS

test instrument: instrument used to perform analysis

test analysis: analysis type

test x_project: project test was assigned to

test version:

test order_number:

test replicate_test:

test replicate_count:

rest sample_number: sample number for sample the analysis

was performed on

® Top depth CSF-A (m): position of observation expressed
relative to the top of the hole.

® Bottom depth CSF-A (m): position of observation expressed

relative to the top of the hole.

Top depth CSF-B (m):

Bottom depth CSF-B (m):

analyte: element or ion that was measured

concentration (mM): concentration of the measured analyte in

mM

dat_asman_id:

dat_filename:

ssup_asman_id:

ssup_filename:

sample description: observations recorded about the sample

itself

® test test_comment: observations about a measurement or the
measurement process; some measurement observations may
be under Result comments

® result comments: observations about a measurement or the

measurement process; some measurement observations may

be under Test Comments

Troubleshooting

Consult Metrohm'’s IC Troubleshooting guide for information concerning troubleshooting common IC problems. Below are additional issues the
technicians have encountered over the years:

Chromatograms
Check standards are coming out low:

® Dilution error: The percent accuracy of all peaks should be nearly the same

® Guard columns or eluent inline filters are contaminated. Replace them with new parts.

A/S has not drawn up enough sample due to blockage. Check level of fluid in the aspirated vial and note if less sample was extracted. On the

subsequent samples note the flow rate of fluid entering the waste container on the rear of the instrument.

Peak shouldering for anions. Due to contamination of the anions guard column. Replace the guard column.

® [ssues with the chromatography may occur if the in-line filters are clogged. Check the pressure readings saved with the individual sample
results to verify the instrument was working properly.

Column

® Retention times for peaks are shifting. Usually means the resin in the column is being poisoned by other components in the sample matrix.
The column will need to be regenerated per the Metrohm manual. Change the guard column in the meantime to prevent additional shifting of
retention times.

Detector:

® Detector signal is highly variable. Usually means that air has gotten into the conductivity meter. Remove the line from the end of the
chromatographic column and attach it to a syringe filled with DI. Slowly force water through the line and detector. If the bubble does not
dislodge, attach the syringe to the line coming out of the back of the detector, and backflush DI through.

Pump:

Pressure is high: blockage

Pressure is low: bad pump, or a leak

Pump pressure is variable. Usually means there is blockage or air in the eluent flowpaths.
Leak is present.

Autosampler:

* Autosampler collided with test tube projecting from the rack and needs to be reconfigured.
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Software issues:

MagIC Net misidentified an analyte: This usually happens when two peaks are within the same retention time window. Sulfate is the worst offender.
Reprocess the sample by adjusting the time window to identify the correct analyte.

LIMS Component Table

Most LIMS components are directly saved as a pair of components: a RESULT table name for the name of the parameter, and RESULT.entry for the
text or numeric result. For the lon Chromatograph, however, it was necessary to create a different structure. Two of the name fields in the RESULT
table are analyte and concentration, and any given result is a marriage of these two fields (e.g., analyte = Sulfate and concentration = 28.657. These
are organized on the RESULT table by use of the RESULT.replicate_count field, so a given analyte entry and concentration entry have the same
replicate_count (e.g., /0, /1).

ANAL ' TABLE
YSIS

IC SAMPLE
IC SAMPLE
IC SAMPLE
IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE
IC SAMPLE
IC SAMPLE
IC SAMPLE
IC SAMPLE
IC SAMPLE
IC SAMPLE
IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

IC SAMPLE

NAME

Exp

Site

Hole

Core

Type

Sect

AW

text_id
sample_numb
er

label_id

sample_name

x_sample_state
X_project
x_capt_loc
location
x_sampling_to
ol

changed_by
changed_on
sample_type
x_offset
x_offset_cm
X_bottom_offs
et_cm

x_diameter

x_orig_len
x_length
x_length_cm
status
old_status
original_sample

parent_sample

ABOUT TEXT

Exp: expedition number

Site: site number

Hole: hole number

Core: core number

Type: type indicates the coring tool used to recover the core (typical types are F, H, R, X).
Sect: section number

A/W: archive (A) or working (W) section half.

Text_ID: automatically generated database identifier for a sample, also carried on the printed labels. This identifier is
guaranteed to be unique across all samples.

Sample Number: automatically generated database identifier for a sample. This is the primary key of the SAMPLE table.
Label identifier: automatically generated, human readable name for a sample that is printed on labels. This name is not
guaranteed unique across all samples.

Sample name: short name that may be specified for a sample. You can use an advanced filter to narrow your search by this
parameter.

Sample state: Single-character identifier always set to "W" for samples; standards can vary.

Project: similar in scope to the expedition number, the difference being that the project is the current cruise, whereas expedition
could refer to material/results obtained on previous cruises

Captured location: "captured location," this field is usually null and is unnecessary because any sample captured on the JR has
a sample_number ending in 1, and GCR ending in 2

Location: location that sample was taken; this field is usually null and is unnecessary because any sample captured on the JR
has a sample_number ending in 1, and GCR ending in 2

Sampling tool: sampling tool used to take the sample (e.g., syringe, spatula)

Changed by: username of account used to make a change to a sample record
Changed on: date/time stamp for change made to a sample record

Sample type: type of sample from a predefined list (e.g., HOLE, CORE, LIQ)
Offset (m): top offset of sample from top of parent sample, expressed in meters.

Offset (cm): top offset of sample from top of parent sample, expressed in centimeters. This is a calculated field (offset,
converted to cm)

Bottom offset (cm): bottom offset of sample from top of parent sample, expressed in centimeters. This is a calculated field
(offset + length, converted to cm)

Diameter (cm): diameter of sample, usually applied only to CORE, SECT, SHLF, and WRND samples; however this field is null
on both Exp. 390 and 393, so it is no longer populated by Sample Master

Original length (m): field for the original length of a sample; not always (or reliably) populated

Length (m): field for the length of a sample [as entered upon creation]

Length (cm): field for the length of a sample. This is a calculated field (length, converted to cm).

Status: single-character code for the current status of a sample (e.g., active, canceled)

Old status: single-character code for the previous status of a sample; used by the LIME program to restore a canceled sample
Original sample: field tying a sample below the CORE level to its parent HOLE sample

Parent sample: the sample from which this sample was taken (e.g., for PWDR samples, this might be a SHLF or possibly
another PWDR)
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IC SAMPLE ' standard

IC SAMPLE | login_by

IC SAMPLE ' login_date

IC SAMPLE  legacy

IC TEST test
changed_on

IC TEST test status

IC TEST test old_status

IC TEST test

test_number

IC TEST test
date_received

IC TEST test instrument

IC TEST test analysis

IC TEST test x_project

IC TEST test
sample_numb
er

IC CALCU  Top depth
LATED | CSF-A (m)

IC CALCU | Bottom depth
LATED | CSF-A (m)

IC CALCU  Top depth
LATED @ CSF-B(m)

IC CALCU  Bottom depth
LATED | CSF-B (m)

IC RESULT  analyte

IC RESULT | concentration
(mM)

IC RESULT ' dat_asman_id

IC RESULT  dat_filename

IC RESULT ' ssup_asman_id

IC RESULT ' ssup_filename

IC SAMPLE  sample
description

IC TEST test

test_comment

IC RESULT | result
comments

Standard: T/F field to differentiate between samples (standard=F) and QAQC standards (standard=T)

Login by: username of account used to create the sample (can be the LIMS itself [e.g., SHLFs created when a SECT is
created])

Login date: creation date of the sample
Legacy flag: T/F indicator for when a sample is from a previous expedition and is locked/uneditable on this expedition

TEST changed on: date/time stamp for a change to a test record.

TEST status: single-character code for the current status of a test (e.g., active, in process, canceled)
TEST old status: single-character code for the previous status of a test; used by the LIME program to restore a canceled test

TEST test number: automatically generated database identifier for a test record. This is the primary key of the TEST table.
TEST date received: date/time stamp for the creation of the test record.

TEST instrument [instrument group]: field that describes the instrument group (most often this applies to loggers with multiple
sensors); often obscure (e.g., user_input)

TEST analysis: analysis code associated with this test (foreign key to the ANALYSIS table)

TEST project: similar in scope to the expedition number, the difference being that the project is the current cruise, whereas
expedition could refer to material/results obtained on previous cruises

TEST sample number: the sample_number of the sample to which this test record is attached; a foreign key to the SAMPLE
table

Top depth CSF-A (m): position of observation expressed relative to the top of the hole.

Bottom depth CSF-A (m): position of observation expressed relative to the top of the hole.

Top depth [other] (m): position of observation expressed relative to the top of the hole. The location is presented in a scale

selected by the science party or the report user.

Bottom depth [other] (m): position of observation expressed relative to the top of the hole. The location is presented in a scale
selected by the science party or the report user.

RESULT analyte name: name of the analyte for this result (e.g., Calcium, Sulfate)

RESULT concentration (mM): concentration of the analyte

RESULT data ASMAN_ID: serial number of the ASMAN link for the data file (binary format)

RESULT data filename: file name of the data file (binary format)

RESULT spreadsheet uploader ASMAN_ID: serial number of the ASMAN link for the spreadsheet uploader file
RESULT spreadsheet uploader filename: file name of the spreadsheet uploader file

SAMPLE comment: contents of the SAMPLE.description field, usually shown on reports as "Sample comments"

TEST comment: contents of the TEST.comment field, usually shown on reports as "Test comments"

RESULT comment: contents of a result parameter with name = "comment,” usually shown on reports as "Result comments"

Archived Versions

LMUG-MetrohmlonChromatographUserGuide-230220-1910-152.pdf

IC_UG_376_VPP.docx
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